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Software License Agreement 

 

FARSTONE TECHNOLOGY, INC. (FARSTONE) END USER LICENSE AGREEMENT FOR TOTAL 
RECOVERY PRO 7, HEREAFTER REFERRED TO AS THE “SOFTWARE”  

PLEASE READ CAREFULLY: THE USE OF THIS “SOFTWARE” IS SUBJECT TO THE 
“SOFTWARE” LICENSE TERMS OF FARSTONE AND OTHER LICENSORS WHO’S SOFTWARE 
MAY BE BUNDLED WITH THIS PRODUCT.  

BY YOUR USE OF THE “SOFTWARE” INCLUDED WITH THIS PRODUCT YOU AGREE TO THE 
LICENSE TERMS REQUIRED BY THE LICENSOR OF THE “SOFTWARE”, AS SET FORTH BELOW. 
IF YOU DO NOT AGREE TO THE LICENSE TERMS APPLICABLE TO THE “SOFTWARE”, YOU 
MAY RETURN THE ENTIRE UNUSED PRODUCT FOR A FULL REFUND.  

 

LICENSE AND WARRANTY:  

The software that accompanies this license (the “Software”) is the property of FARSTONE or 
its licensors and is protected by copyright law. While FARSTONE continues to own the 
Software, you will have certain rights to use the Software after your acceptance of this 
license. Except as may be modified by a license addendum which accompanies this license, 
your rights and obligations with respect to the use of this Software are as follows:  

 

A. Single User License: 

(a) Use the “Software” on a single computer system or network, and only by a single user at 
a time. If you wish to use the “Software” for more users, you will need an additional License 
for each user.  

(b) Make one copy of the “Software” in machine-readable form solely for back-up purposes 
provided you reproduce FarStone’s copyright proprietary legends. Notwithstanding the 
foregoing, the “Software” may be used on the home, laptop or other secondary computer of 
the principal user of the “Software”, and an additional copy of the “Software” may be made 
to support such use. As used in this License, the “Software” is “in use” when it is either 
loaded into RAM or installed on a hard disk or other permanent memory device. The 
“Software” may be “in use” on only one computer at any given time. (Different License 
terms and fees are applicable for networked or multiple user applications.) As a specific 
condition of this License, you agree to use the “Software” in compliance with all applicable 
laws, including copyright laws, and that you will not copy, transmit, perform or distribute 
any audio or other content using the “Software” without obtaining all necessary Licenses or 
permissions from the owner of the content.  

 



B. Multiple User License:  

Make one copy of the “Software” in machine-readable form solely for back-up purposes, 
provided you reproduce FarStone’s copyright proprietary legends.  

You must acquire and dedicate a License for each separate computer on which any part or 
portion of the “Software” is installed or run as used in this License, the “Software” or any 
part or portion of the “Software” is “in use” when it is either loaded into RAM or installed on 
a hard disk or other permanent memory device including any networked or shared 
environment where either direct or indirect connections are made through software or 
hardware which pools or aggregates connections.  

As a specific condition of this License, you agree to use the “Software” in compliance with all 
applicable laws, including copyright laws, and that you will not copy, transmit, perform or 
distribute any audio or other content using the “Software” without obtaining all necessary 
Licenses or permissions from the owner of the content.  

 

C. Restrictions:  

You may not distribute copies of the “Software” to others or electronically transfer the 
“Software” from one computer to another over a network. You may not post or otherwise 
make available the “Software”, or any portion thereof, in any form, on the Internet. You 
may not use the “Software” in a computer service business, including in time-sharing 
applications. The “Software” contains trade secrets and, in order to protect them, you may 
not decompile, reverse engineer, disassemble, or otherwise reduce the “Software” to a 
human-perceivable form. YOU MAY NOT MODIFY, ADAPT, TRANSLATE, RENT, LEASE, LOAN, 
RESELL FOR PROFIT, DISTRIBUTE, NETWORK OR CREATE DERIVATIVE WORKS BASED 
UPON THE “SOFTWARE” OR ANY PART THEREOF.  

 

D. Limited Warranty: 

FarStone warrants that the media on which the Software is distributed will be free from 
defects for a period of fourteen (14) days from the date of delivery of the Software to you. 
Your sole remedy in the event of a breach of this warranty will be that FarStone will, at its 
option, replace any defective media returned to FarStone within the warranty period or 
refund the money you paid for the Software. FarStone does not warrant that the Software 
will meet your requirements or that operation of the Software will be uninterrupted or that 
the Software will be error-free.  

THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, WHETHER 
EXPRESS OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. THIS WARRANTY GIVES 



YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE 
TO STATE. 

 

E. Limitation of Liability:  

IN NO EVENT WILL FARSTONE OR ITS LICENSORS BE LIABLE TO YOU FOR ANY INCIDENTAL, 
CONSEQUENTIAL OR INDIRECT DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, 
OR LOSS OF DATA, EVEN IF FARSTONE OR A LICENSOR HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. Some states 
do not allow the exclusion or limitation of special, incidental, or consequential damages, so 
the above limitation or exclusion may not apply to you.  

 

F. General:  

You acknowledge that you have read this Agreement, understand it, and that by using the 
“Software” you agree to be bound by its terms and conditions. You further agree that it is 
the complete and exclusive statement of the agreement between FarStone and you, and 
supersedes any proposal or prior agreement, oral or written, and any other communication 
between FarStone and you relating to the subject matter of this Agreement. No additional or 
any different terms will be enforceable against FarStone unless FarStone gives its express 
consent, including an express waiver of the terms of this Agreement, in writing signed by an 
officer of FarStone. You assume full responsibility for the use of the “Software” and agree to 
use the “Software” legally and responsibly.  

Should any provision of this Agreement be declared unenforceable in any jurisdiction, and 
then such provision shall be deemed severable from this Agreement and shall not affect the 
remainder hereof. FarStone reserves all rights in the “Software” not specifically granted in 
this Agreement.  

 

Additional Terms and Conditions: 

 

In addition to the above agreement, the following terms and conditions will also apply to 
Your use of the Software:   

 

A. You may use the Software on one Device to clone, or apply an image of a hard drive on 
that Device, or to another hard drive on the same Device, a replacement Device, secondary 
media, or network drive.   

 



B. You may use the Software on a Device to create an image file of a hard drive on that 
Device and store the image file on fixed or removable media for disaster recovery purposes. 

 

C. You may use the Software as a boot disk to re-apply the hard drive image that was 
created for disaster recovery purposes to the hard drive on the Device from which the 
disaster recovery image was made or on a replacement Device provided that the software 
has been removed from the original Device. 

 

D. You may use the Software to clone a hard drive from a Device to a replacement Device, 
in the manner described in the Software documentation and to use the Software on the 
replacement Device provided that the Software has been removed from the original Device. 

 

E. You may not use the Software commercially or non-commercially for the purpose of 
creating an image on multiple Devices or hard drives, except for multiple hard drives 
installed in or attached directly to the original Device. 

 

F. For the purposes of this License Agreement, a virtual device is considered the same as a 
physical device. 

 

G. If the Software you have licensed includes the Pre-OS the following uses and restrictions 
apply to the Software: 

 

(i)  The Pre-OS contains Windows® software licensed from Microsoft Corporation. Microsoft 
Corporation has no liability to You for the Component.  Any support for the Component will 
be provided by FarStone in accordance with FarStone’s then-current support guidelines. 

 

(ii)  THE PRE-OS CONTAINS A TIME-OUT FEATURE THAT WILL AUTOMATICALLY RE-BOOT 
THE DEVICE AFTER SEVENTY-TWO HOURS OF CONTINUOUS USE. THIS TIME-OUT FEATURE 
WILL RESET EACH TIME THE COMPONENT IS RE-LAUNCHED. 

 

(iii)  The Pre-OS may be used as a boot, diagnostic, disaster recovery, setup, restoration, 
emergency service, installation, test, and configuration utility program.  Use of the 
Component as a general purpose operating system or as a substitute for a fully functional 
version of any operating system product is strictly prohibited. 



 

Windows® is a registered trademark of Microsoft Corporation. 

 

Should you have any questions concerning this Agreement, you may contact FarStone by 
writing to:  

FarStone Technology, Inc. 

Legal Department  

1758-B North Shoreline Blvd 
Mountain View, CA 94043 
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Chapter 1: Introduction 

1.1 Product Overview 

FarStone Total Recovery Pro 7’s hard drive imaging and cloning features let 

you quickly recover, replace, or upgrade your hard drive in case of any data 

disaster. Your operating system, files and settings will appear exactly as 

they were when you cloned or imaged your hard drive.  

 

Simple enough for a home user, FarStone Total Recovery Pro 7 still has 

plenty of features for the system administrator, who can copy a single disk 

image onto multiple computer systems, dramatically reducing the time 

needed to install new software, configure settings, and load data. FarStone 

Total Recovery Pro 7 offers incremental backup, which could allow you to 

perform most imaging and recovery tasks without ever leaving the 

Windows environment.  

 

FarStone Total Recovery Pro 7 backs up onto a network place, which is not 

available in the personal edition of Total Backup Recovery. With this feature, 

your data security cannot be influenced by disasters like, earthquake, fire 

or flood, any more. The whole process of all functionalities is very easy for 

everyone only by clicking buttons. So the FarStone Total Recovery Pro 7 is 

the best choice for backup and recovery. 

With a special recovery environment (Recovery Manager), you can run 

Total Backup Recovery  to back up and restore damaged partitions even if 

Windows won't start for some reason. Also some other features of Total 

Backup Recovery are still available in this recovery environment. 

 

1.2 Powerful Backup Features 

 

Total Recovery Pro 7’s Suite of backup features included: 

• Hard Drive Imaging: Backs up and restores a system with a complete 

copy of all files, installed software, partition information, and system 

settings.  



• Incremental Backup: Manually or automatically updates saved disk 

images without ever leaving Windows. Incremental backup points log only 

the changes that have occurred since the last Complete Backup. 

• File Backup: Manually or automatically backs up selected file/folder, file 

extension, etc. 

• Universal Restore: Restores a complete system image of a particular 

configuration to a different hardware configuration system or a Virtual 

Machine. 

1.3 Other Features and Benefits  

• Complete External Backup: Store a complete system image on a USB 

hard drive, or on a network share. 

• Easy Disk Image Updates: Incremental Backup lets you quickly update 

your saved disk image without ever leaving Windows. 

• Flexible Backup: Back up your client’s hard drive to another local hard 

drive, network drive, or a USB device.  

• Rapid, Controlled Recovery: Rebuild system via Complete Restore in 

minutes, not hours or days. 

• Partition Support: Supports FAT，FAT32, NTFS and other unknown 

partitions. 

• Hardware Support: Supports IDE, EIDE, SATA, and SCSI/RAID hard 

drives.  

• 100% Protection: Restore an operating system damaged by corrupt 

software, human error, a virus attack, or a software bug. 

• FTP Support: Save another data copy onto a remote FTP server to 

enhance the protection of files and the entire computer. 

• Virtual Machine Support: Convert the backup image into a VMware file 

image format to run it on a virtual machine. 



1.4 Newly-added Features 

• Google Desktop Search: Enable search engine support if you want to use 

Google Desktop to locate and recover files and folders contained in Backup 

Images. 

• Customized File Backup Search: Users can restore files by searching for 

customized backup files. 

• Web Browser：Users can go through the website in PE by clicking Launch 

Web Brower. 

• Explorer Window：Files and folders on your computer will be displayed by 

clicking Open Explorer Window. 

• One-Click Backup: Create an image for system partition with one click. 

(details refer to4.2.1.1 ) 

• Recovery Manager: By clicking active recovery manager in the tools tab, 

you can enter the recovery manager interface (details refer to 4.6.3). 

• Change Security Identifier: If you select the utility, you can get accurate 

restored data in the process of Universal Restore.  

• Unmount Preview Drive: It can help to remove the preview backup image 

from your computer. 

 



Chapter 2: Installing and Uninstalling 

Total Recovery Pro 7         

2.1 System Requirements 

• CPU: Pentium or higher 

• RAM: 512 MB or more (1 GB or more for Vista) 

• Hard Drive: 250 MB free space 

• Supported Desktop Operating Systems: Windows® XP (32-bit & x64), 

Windows® Vista (32-bit & 64-bit), Windows 7 

 

2.2 Start Total Recovery Pro 7 Installation 

 

If you purchased a CD: 

Insert the CD into your CD-ROM drive. The setup program should start 

automatically. If it doesn’t, browse the CD and double-click on the Autorun.exe. 

Follow the prompts displayed to finish your installation.    

If you purchased an electronic download: 

Save the executable file to your hard drive. Double-click on the file to launch 

the Total Recovery Pro 7 installer. Follow the prompts to finish your installation.   



2.2.1 Installing Total Recovery Pro 7  

1. Select Setup, and click Next.  

2.  Select the language preference of the application, and click Next. 

3.  Carefully read the software license agreement. If you accept the terms of the 

agreement, select I accept the terms in the license agreement, and click 

Next. 

4.  Enter your personal information and serial number, and click Next. 

  

 

Note 
Installation without purchasing a serial number will activate a time-
limited evaluation version of Total Recovery Pro 7. 

5. Click Next to install to the default folder, or Change to select another location.  

6. Click Install to launch the installation process.  

7. Click Finish to complete the installation. You are required to restart your 

computer in order to launch Total Recovery Pro 7. 

2.3 Uninstalling Total Recovery Pro 7  

1. From the Windows Start menu, select Start ->Settings->Control Panel. 

2. Double-click Add/Remove Programs, and select Change or Remove 

Programs. 

3. Select Total Recovery Pro 7, and click Remove to begin uninstalling the 

associated component. 



Chapter 3: Total Recovery Pro 7 Specific 

Terminology 

3.1 File Backup 

Total Recovery Pro 7 File Backup monitors file changes. When a change is detected, 

Total Recovery Pro 7 will record it and back it up according to your schedule. File 

backups can be stored locally or externally. 

3.2 Hard Drive Imaging 

Hard Drive Imaging can be used for bare-metal disaster recovery when hard drive 

failure occurs. 

3.3 Full and Incremental Backups 

Full and incremental backup solutions aim to make storing several copies of the 

source data more feasible. To accomplish this, a complete backup is taken initially 

and then incremental backups can be scheduled or run manually (Incremental 

backup only stores the files or sectors that have changed since the previous full or 

incremental backup). Restoring a system to a certain point involves locating the 

complete backup and the incremental backups executed between the time of the 

complete backup and the time of the restore. 

3.4 Total Recovery Pro 7 Universal Restore 

With Total Recovery Pro 7 Universal Restore, there is no need to reinstall the 

operating system, applications, configuration files, individual files, and folders into 

the new system with different hardware configuration, or to a virtual machine. 

With Universal Restore, you can restore your system onto a similar or a different 

(than original) hardware configuration with a few mouse-clicks.  

 



Chapter 4: Start Using Total Recovery 

Pro 7 

To launch Total Recovery Pro 7, double-click the Total Recovery Pro 7 on your 

desktop or select Start –>All Programs –>FarStone->Total Recovery Pro 7. 

 

 

Tip 

If Google Desktop is installed, when you start up Total Backup Recovery, 
it will confirm if you want to install “The Third Party Plug-in”. Click “OK” 
to begin installation.  

When entering the following interface, please select your wanted file 
types and options and “File Backup Index Plugin (Indexes 
FileBackup Recovery Points (*.FDB))，then Google Desktop will 
establish related indexes. You can open the .FDB files with the Google 
Desktop Search. 

 

 

 

 

 



 

 

 

4.1 Main Console 

4.1.1 Quick Start 

This displays a shortcut menu for File Backup, Back up Computer. 

 

                                *Total Recovery Pro 7 Main Console 

One-Click Backup – Protect your PC with one click.  

File Backup – Click here to back up the selected files and folders.  

Back Up Computer(s) – Click here to back up the entire hard drive or partition(s) 

to an external location. 



4.1.1.1 One-Click Backup  

1. Click One-Click Backup. 

2. A box pops up for you to choose the location where the backup files will save. 
In this box, you also have the option to edit the schedule. 

 

A : Click Browse for location to enter the following box. You can save the 
image to the local hard disk, a CD, or a network by entering the location or 
choosing the location in the drop-down list. 



 

B : Click Edit Schedule. You can set anytime to backup files based on your 
demand. 



 

 

4.1.2 Jobs 

View Complete Backup, and File Backup jobs. 

• Back Up Computers – Total Recovery Pro 7 shows all file 

backup jobs related to this computer. There are four functions 

you can perform on each computer backup job. 

a.  Detail – View detailed information about the backup jobs you’ve 

created,    including the job name, source, destination, scheduled 

settings, description and FTP address for the selected backup. 

b.  Edit Schedule – Schedule incremental updates for the backup job 

you’ve created; change other scheduled settings. 



c.  Offsite Copy – Change FTP settings or click Restore Defaults to 

restore the FTP settings to be the same as it in Settings. 

d. Back Up Now – Immediately Create an Incremental Backup. 

e. Delete – Delete the selected job. 

 

Scheduling Complete Backups 
1.Complete backups and incremental updates can be created according 
to the pre-set schedule. 

2. If the system is busy, Total Recovery Pro 7 will not be able to perform 
the scheduled backup job, and will automatically try again later. 

 

• File Backup – Total Recovery Pro 7 displays all of the file 

backup jobs related to this computer. You will see the following 

options under each job: 

a.  Detail - View detailed information about a backup job you’ve 

created, including the job name, job destination, scheduled 

settings and FTP address. 

b.  Edit Schedule – Change scheduled settings for the backup 

job you created. 

c.  Offsite Copy – Change FTP settings or click Restore Defaults to 

restore the FTP settings to be the same as it is in Settings.  

d. Add Files - Add files to your File Backup list. 

e. Back Up Now - Run the selected incremental File Backup job 

immediately. 

f. Delete - Delete the selected job. 

 Scheduling File Backups 
1. If your system is busy, Total Recovery Pro 7 will not be able to initiate 
the backup process.  Total Recovery Pro 7 will attempt to perform the 
backup again after 5 minutes. 



2. The following files are not backed up: 

a. Files in the Recycle Bin 

b. Files in the System Volume Information directory, 
pagefile.sys, and the _$temp directory 

c. Hiberfil.sys 

d. Files with “.rit” and “.tmp” extensions 

e. Microsoft Office temporary files 

f. Files in Total Recovery Pro 7’s installation folder 

g. Files in the Backup Destination directory of the backup job 
that is currently running 

h. Files in the Temp directory 

 

4.1.3 View Logs 

 

This feature records all events of Total Recovery Pro 7, including warnings, errors 

and operations. 

Save - Export the logs and save the event record as an excel file. 

Delete - Delete the selected event(s). 

Delete All - Delete all the saved events. 

 

 

4.1.4 Settings  

 

• Offsite Copy - By setting the following options, users can save another 

image copy on an FTP server to ensure the data protection. This is the 

default for your file backup and complete backup.  

a. FTP information – Enter the address and port. 



b. FTP account – Enter the username and password of the FTP. You can 

select Anonymous if the FTP server is shared to all users in the network. 

c. FTP connection retry frequency – Enter Retry attempts (maximum is 

100), Delay between retries (maximum is 600). 

• E-mail Notification - By configuring the below settings, Total Recovery 

Pro 7 will send an E-mail to your specified E-mail account when the backup 

is completed. 

 

a. E-mail configuration - Enter preferred E-mail address and other server 

settings. 

 

b. Send test email – Click here to test proper setting functionality. 

 

c. Notification events – Specify the events for which you would like to 

receive notification via E-mail regarding the backup operations. 

 

 



*E-mail Notification Setup 

            

   

4.2 Backup Console 

4.2.1 File Backup 

1.  Start the Total Recovery Pro 7 Program. Select Back Up and then click File 

Backup. 

2.  Select New File Backup to create a new job. 

3.  Enter a name for your new job 

4. Select the file(s) you want to back up. You can also click Add Files/Folders or 

Add FileTypes to add file type, folder, or individual file to back up according 

to your preference. Click Next to continue.  

Add Files/Folders: Click this to select the files or folders you want to add 

from Windows® Explorer. 

 Add File Types: Click this to enter the Select File Types interface, as shown 

below.  



 

*Select Files for Backup or Add File/Folders or Add File Types 

a. Click Delete Type to remove file types you don’t want to back up. 

b. Click Add New Type to add new file type in the backup list. You will 

need to enter a file type extension and a description. Or click Add 

Group to create a new file type group. You will need to enter a group 

name. 

5.   Select a location to store the backup file, such as a shared folder or locally, on 

the system. Click Next to continue. If you want to save one more image copy 

on the FTP, select Enable offsite copy (optional), and click Settings to 

configure these below.  



 

*Enable Offsite Copy 

a. FTP information – Enter the address and port. 

b. FTP account – Enter the username and password of the FTP. You can 

select Anonymous if the FTP server is shared with all users in the 

network. 

c. FTP connection retry frequency – Enter Retry attempts (maximum is 

100), Delay between retries (maximum is 600). 

d. Restore Defaults – Clear all FTP settings.  

 

Tip 
This feature only supports local image files. If you want to use the image 
file on the network or disc, you should first save it onto the local 
computer. 

The entire FTP upload process executes in the background. If the program 
fails to upload backup data onto the FTP server, it will be recorded in logs 



which can be checked through View Logs. Total Recovery Pro 7 will retry 
three times automatically until the next startup. 

4. Click Start Now to proceed. You can also choose to run daily, weekly, or 

monthly backups.  

 

Note 
If you select weekly or monthly, then the program will make a base 
backup at the 1st backup of each week or each month, after which the 
incremental backup will be made. These base and incremental backup 
files will be kept in one backup set only.  

If you set the Quota Management checkbox to “Keep 3 Backup Sets”, 
then the program will reserve space for only 3 backup sets (backup 
setting number is 99). For example: If you select “monthly” and decide 
to make 3 backups sets in one month, then the 1st backup set of that 
month will be deleted to make space for the 1st backup set of the next 
month.  

Click Advanced for optional settings including: backup priority, network 

connection speed, compression mode, password protection, image split, backup 

description, configuration of E-mail notifications and Pre/Post command: 

 



*Optional Advanced Settings 

7. Review your information and settings, and click Next to launch the backup 

process. For best results, close all of the files you want to back up prior to 

launching your backup job. 

8. Click Finish to return to the main console. Or to specify your preferred 

Schedule Settings, click here to create a schedule now. By doing so, you can 

choose to repeat the backup operation at a specific scheduled time. 

Updating a File Backup Job 

1. Launch Total Recovery Pro 7.  

2. Select Back Up, and click File Backup. 

3. Select Incremental File Backup, and click Next. 

4. Select an existing job from the Job List. 

5. Review your information and settings, and click Next to launch the 

incremental backup.  

6. Click Finish to return to the main console. 

 

4.2.2 Back Up My Computer 

1.  Start the Total Recovery Pro 7 Program. Select Back Up and then click Back 

Up Computer(s). 

2.  Select Create a New Complete Backup. 

3.  Enter a name for your new Complete Backup and click Next. 

4.  Select the partition(s) or the entire hard disk to back up, and click Next. 

 

Tip: 
If you want to restore with Universal Restore later, you must choose 
your system partition (e.g. C:) to back up. 



5. Enter the storage path and click Goto. Or select a destination location on a 

hard drive, USB storage medium, or a network location to store the image file.  

A .  If you choose to back up the image to a USB or CD/DVD, you can select 

to place Recovery Manager on the media by clicking Yes when you are 

prompted, ”Do you want to place Recovery Manager on media?” 

 

Tip: 
After backing up your computer onto USB or CD/DVD, you can directly 
boot into Recovery Manager by selecting “boot from USB or CD/DVD” 
when inserting the USB or putting the CD/DVD into the drive. 

 

 

 

B.  If the destination location is just USB, you will see the tip “Do you want to 

place Recovery Manager on media? NOTE: This will overwrite all the data on 

the destination.” 



C.  If you want to save one more image copy on the FTP, select Enable offsite 

copy (optional), and click Settings to configure these below.  

a. FTP information – Enter the address and port. 

b. FTP account – Enter the username and password of the FTP. You can 

select Anonymous if the FTP server is shared to all users in the 

network. 

 c. FTP connection retry frequency – Enter Retry attempts (maximum is 

100), Delay between retries (maximum is 600). 

 d. Restore Defaults – Clear all FTP settings.  

 

Tip 
This feature only supports the local image file. If you want to use the 
image file on the network or disc, you should first save it on the local 
computer.  

The entire FTP upload process executes in the background. If the 
program fails to upload backup data onto the FTP server, it will be 
recorded in log files which can be checked through View Logs. Total 
Recovery Pro 7 will retry three times automatically until the next startup. 

6.  Click Next to continue. 

7.  Click Start Now to proceed. You can also choose to run daily, weekly or 

monthly backups. 

 

Note 
If you select weekly or monthly, then the program will make a base 
backup at 1st backup of each week or each month, after which the 
incremental backup will be made, and this base and incremental backup 
files will be kept in one backup set only.  

If you set the Quota Management checkbox to “Keep 3 Backup Sets”, 
then the program will reserve space for only 3 backup sets (backup 
setting number is 99). For example: If you select “monthly” and decide 
to make 3 backups sets in one month, then the 1st backup set of that 
month will be deleted to make space for the 1st backup set of the next 
month. 



8. Click Next to begin backing up the files. You can choose the tip, "Shut down 

the computer when backup is completed" in the right corner of the interface in 

the process of files backup. However，when image backup is about to complete, 

a box will pop up to give you the tip that you can cancel or continue the 

behavior within the limited time.  

  

 

9.  Optional settings will pop-up if you click Advanced. These settings include: 

backup priority, network connection speed, compression mode, password 

protection, image split, backup description, configuration of E-mail notification 

and Pre/Post command. 

10. Click Next. 

11. Review the information and settings that have been specified. Click Next to 

launch the backup process. Or click Previous to modify setting(s). 

 

Tip 
If the system is busy, and Total Recovery Pro 7 cannot successfully start 
the backup process, Total Recovery Pro 7 will try to back up again. 

12.  Click Finish to return to the main console. If you would like to edit the 

schedule for this job, select click here to create a schedule now. 

Creating an Incremental Backup 

1. Launch Total Recovery Pro 7.  

2. Select Back Up and click Back Up Computer(s). 



3. Select Incremental Backup and click Next. 

4. Select an existing job from the Job List. 

5. Review your information and settings, and click Next to launch the 

incremental backup.  

6. Click Finish to return to the main console.  

 

4.3 Restore Console 

 

4.3.1 Restore Files 

To restore file(s), please do the following: 

1.  Select Restore and then click Restore Files. 

2.  Select a backup image file from the drop down list. You can also click here to 

select it on a network share. Click Next to continue. 



 

*Select backup image from network share 

3. Select Files from the most recent backup or Files from a previous backup 

and click Next. If you select Files from a previous backup, please select the 

backup point you want to restore from the list. 

4. If you select “Please select common restoration or special restoration”, 

then click Next, skip to step 6; if you select “Search special files for the 

restoration”, then click Next, skip to step 5. 

5. Click Search to choose the file(s), or input the file name you want to restore, 

then click Search.  

6. Select the file(s) you want to restore.  

7. Select a location to save the restored files: 



a. If New Desktop Folder is selected, the restored files will be saved 

in a new folder on the client’s desktop, with the folder hierarchy 

preserved exactly as it was backed up.  

b. If Original Location is selected, the restored files will be saved to 

their original folder and will overwrite existing files in that folder with 

the same name.  

c. If Another Folder is selected, click Select a folder to browse a 

folder on the network. The restored files will be kept in their original 

folder hierarchy. 

8. Click Next to start the restore after confirming the source and the destination. 

9. Click Finish to return to the main console. 

4.3.2 Restore Your Computer 

To restore a partition or the entire hard drive, please do the following: 

1. Launch Total Recovery Pro 7. 

2. Select Restore, and click Restore Your Computer. 

3. Select a backup image from the list, or click here to select an image file stored 

on a network share. Click Next to continue. 

4. Select a Complete Backup point or any Incremental Backup point to restore 

from, and click Next. 

If you want to restore your entire physical disk drive, click One-Click Restore, 

then click Restore to begin the restoration process; or click No to exit. 

5. Select Do not use Universal Restore, and click Next.  

6. Select to restore a single partition or the entire hard drive, and click Next.  

7. Click OK to return to the original location, or click Cancel to select another 

location. If you choose OK, skip to step 11.  



8. Select a destination partition or a destination hard drive to be restored from the 

image file, and click Next.  

9. To restore a single partition, skip to step 10. To restore the entire hard disk, 

please select a restore option.  

a.  Select the checkbox if you would like to modify the destination 
partition size. 

b. Do not check the box if you have multiple systems or a hidden 
partition. 

If you selected option a, double click the partition capacity to be resized from the 
list. If you selected option b, skip to step 10. 

10. When it displays the structure of the destination partition, double-click the 
highlighted partition and modify its size, and click Next to continue. 

 

Tip 
The restoration process will require your computer to reboot into the 
FarStone Recovery Environment. 

11. Click Next to start the restoration after confirming the source and the 

destination.  

12. Click Yes to begin the restoration process. Then Click OK to enter the 

FarStone recovery environment to complete the restoration process 

automatically. 

Your computer will restart to complete the restoration. After that, it will reboot into 

Windows automatically.  

4.3.3 Perform Universal Restore 

You can restore the system partition or the entire hard drive of the selected client 

to dissimilar hardware. 

1. Launch Total Recovery Pro 7.  

2. Select Restore, and click Restore Your Computer.  

3. Select a backup image from the list, or click here to select an image file stored 

on a network share. Click Next to continue. 



 

Note 
The image you selected needs be supported by Universal Restore. More 
information about Universal Restore, please refer to section 4.1.3.  

4. Select a Complete Backup point or any Incremental Backup point to restore 

from, and click Next. 

5. Select to restore with Universal Restore, and click Next.  

 

 

Tip 
If you select the utility, you can get accurate restored data in the 
process of Universal Restore.  

6. When the dialog box appears, click OK to restart your system into FarStone 

Recovery Environment to begin the restoration process, or Cancel to exit.  

After your computer restarts to complete the Universal Restore, you need 

to do the following: 

1. Select to restore a single partition or the entire hard drive, and click Next.  



2. Click OK to restore to the original location, or click Cancel to select another 

location. If you choose OK, skip to step 6.  

3. Select a destination partition or a destination hard drive to be restored from the 

image file, and click Next. 

4. To restore a single partition, skip to step 6. To restore the entire hard disk, 
please select a restore option.  

a. Select the checkbox to modify the destination partition size. 

b. Do not check the box if you have information on multiple systems  

If you selected option a, double click the partition Capacity to be resized 
from the list. If you selected option b, skip to step 6. 

5. When it displays the structure of the destination partition, double click the 
highlighted partition and modify its size, and click Next to continue. 

6. Click Next to continue after confirming all settings.  

7. Click Yes to begin the restoration process. After the restoration process is 
complete, Windows will automatically reboot.  

4.4 Clone Console 

 

4.4.1 Clone Drive 

Clone Drive duplicates one hard drive to another. It eliminates the need to re-

install the operating system, drivers and applications, and enables you to upgrade 

a new hard drive with only a few clicks. 

 

 

Tip 
To use this function you will need to have at least two hard drives on your 
computer. 

The target hard drive should have enough space to store the data of the 
source hard drive. 

1.  Select Clone and then click Clone Drive. 



2.  Select the Source Disk (top pane) and then the Destination Disk (bottom pane). 

You can choose to modify the Destination Partition Size manually by selecting 

Modify the destination partition size. You can also choose not to modify 

the Destination Partition Size by selecting Keep the partition size of the 

destination drive the same as the source drive. Click Next to continue. 

 

Tip 
If you select Keep the partition size of Destination Hard Drive the 
same as the Source Hard Drive, skip to step 4. 

If the Hard Drive you want to clone is going to boot your system, select 
Keep the partition size of Destination Hard Drive the same as the 
Source Hard Drive. 

3.  You can alter the Destination Partition size by double-clicking the entry of 

Destination Partition and change the size in a popup dialog box. Click Next to 

continue. 

4.  After confirming your selections, click Clone Now to proceed or click Previous 

to change your selection. If the system is busy, Total Recovery Pro 7 will 

automatically try to clone again. 

 

Note 
The cloning process will overwrite all data on the destination disk. Click 
Continue to begin the cloning process, or click Cancel to exit. 

5.  Click Shutdown to complete the cloning process. 

 

4.4.2 Clone Partition 

With Total Recovery Pro 7, you can copy data from the source partition into the 

destination partition. 

1.  Select Clone and then click Clone Partition. 

2.  Select a Source Partition in the Hard Drive (top pane). 

 



 

Note 
You can only choose one partition at a time. 
The Source Partition and the Destination Partition cannot be the same. 

 

3.  Select a Destination Partition in the original Hard Drive or another Hard Drive 

(bottom pane), then click Next to continue. 

 

 

Tip 
The selected destination partition must have enough space to hold the 
data of the source partition. 

 

4.  After confirming your selections, click Clone Now to start the duplication 

process or you can click Previous to change your selections. You can start the 

cloning process by clicking Start Clone. If the system is busy, Total Recovery 

Pro 7 will automatically try to clone again.  

 

 

Tip 
The cloning process will overwrite all data on the destination disk. Click 
Continue to begin the cloning process, or click Cancel to exit. 

5.  Click Return to Main Console to complete the process. 

 

4.5 Tools Tab 

4.5.1 ISCSI Initiator 

First, ensure that the iSCSI initiator is installed on the machine. On Windows Vista, 

it is installed by default; other Windows systems require a download and manual 

installation. With this feature, users may connect to the iSCSI device and access a 

great deal of information and configuration options. 



1.  Click on the Tools tab, and select iSCSI Initiator. 

2.  Select the Discovery tab. 

3.  Click Add and enter the IP address or DNS name and Port number for the 

Target Portal on which you would like to log on.  

4.  If your Target Portal requires Chap for authentication, click Advanced. Then 

select the Chap logon information option and enter the Target secret. Click OK 

twice to return to the iSCSI Initiator Properties dialog. 

5.  Verify the Target Portals properties displayed on the Discovery tab. 

6.  Select the Targets tab to view a list of available targets which you can log on 

to. Note that the Status for these targets is shown as Inactive prior to login. 

 

Tip 
a. If your targets are not listed in the Targets tab, verify discovery and 
successfully login by repeating Steps 3 through 6.  

b. If you successfully log into the Target portal but the target is still not 
listed, verify that the target has Logical Unit Numbers (LUNs) assigned to 
the server.  

c. If the target is still not listed, check the System Event Log for errors, 
resolve any issues noted in the log, and repeat Steps 2 through 5 to log 
on to the Target Portal. 

7.  Select the target that you want to log on to and click Log On. 

8.  Click Advanced and enter the username and password of the iSCSI target.  

9.  Verify that your target indicates “Connected” in the Status column.  

Once connected, you can operate the connected iSCSI hard drive as you would a 

physical hard drive on your system (such as backup and restore). 

 

4.5.2 Create a Bootable Rescue Disk 
Create a bootable disk to recover from a system crash or hard drive failure 

1. Insert a blank disc or USB device. 



 

Note 
Before creating a Bootable Rescue Disk, data on the disk should be 
formatted. 

2. Click Tools tab on the left or Tools menu on the top of the interface, and 

then select Bootable Rescue Disk. 

3. Select the CD/DVD drive or the USB device you will be using to create your 

Bootable Rescue Disk, and click Next. 

 

Tip 
If there is some data on the inserted device, you will be asked whether or 
not you wish to erase the disc. If you want to continue, click Erase. Click 
Change to insert another blank CD/DVD, or Cancel to stop the creation 
process. 

4. Click Finish to complete the process. 

4.5.3  Recovery Manager 

The manager can allow you to recover your computer at the boot item before 

the operating system starts through activation. 

You can perform the utility by clicking Activate if you would like to recover the 

computer before booting the operating system. 

1.Click Recovery Manager 

2.Select Activate 

3.Restart your computer and press F4 to enter Recovery Manager. 

If you do not need to enter the Recovery Manager to recover your data, you 

can deactivate it. 



4.6 Utilities 

4.6.1 Convert Backup to Virtual Disk 

After converting the complete backup image as a *.vmdk format successfully, you 

can conveniently load it as a new hard disk on your virtual machine. In doing so, 

all data on the original hard disk is available on that virtual machine.  

 

Tip 
If you did not install VMware Virtual Disk Development Kits, this 
function will be disabled. You can visit the provided link to download it. 

 

1.  Click on the Tools tab, and select Convert Backup to Virtual Disk. 

2.  Enter the storage path of the backup image and click Go to. You may also 

select it locally or remotely and click Next. 

3.  Select a complete backup point or an incremental backup point, and click Next. 

4.  Select to convert a single partition or the entire hard drive, and click Next. 

5.  Choose to either convert to VMware 5 or VMware 6, or click Next.  

6.  Select a local or remote destination path to save the conversion backup. Click 

Next to launch the conversion process. 

7.  Confirm all information about this conversion. Click Next to launch the 

conversion process.  

8.  Click Finish to return to the main console when the process completes. 

4.6.2 Check Image Integrity 

Use this function to check if a complete backup image file is valid and can be used 

for restoration. 

1. Click the Tools tab in the left or the Tools menu on the top of the interface, 

and then select Check Image Integrity. 



2. Enter the storage path of the image you want to check, and click Go to to 

select the image. You can also select the storage path of the image you want 

to check and click Next. 

3. Select to validate either the Complete or Incremental Backup point, and click 

Next to   continue. 

4.  After validating the backup point, click Finish to complete the Image Integrity 

Check. 

 

4.6.3 Preview Backup Image 

Preview the content of the specified partition with the complete backup image to 

make sure you will only restore the needed partition(s).  

1. Click on the Tools tab, and then select Preview Backup Image. 

 

 

Note 
If you have mounted an image before, you will be prompted to dismount 
the previous image. Click Continue to dismount the previous image, or 
Cancel to exit this process. 

2. Enter the storage path of the image you want to preview and click Go to to 

select the image, or select the storage path of the image you want to 

preview and click Next. 

3. Select a complete or incremental backup point, and click Next. 

4. Select the partition you want to preview, and click Mount to load the 

image into the system. 

5. You can now browse and copy data on the preview drive in Windows® 

Explorer.   

6. You can click Yes to mount another image, or No to return to the main 

console. 



If you do not want to preview the image anymore, select Unmount Preview 

Drive on the Tools tab, or select the Tools menu and click Unmount Image 

to close the previewed partition.  

4.6.4 Unmount Preview Drive  

It can remove the preview backup image. 

 



Chapter 5: Total Recovery Pro 7 Pre-OS 

5.1 Enter Total Recovery Pro 7 Pre-OS Manager 

To launch the Total Recovery Pro 7 Pre-OS, select to Activate the recovery 

manager in the tools tab (details refer to 4.6.3), then restart the computer and 

press F4 on your keyboard before Windows® begins to load. You can also enter 

the Pre-OS manager via the following means: a bootable rescue disk, USB drive, 

USB key. 

 

 

Tip 
To prevent its use as a pirated operating system, Windows PE 
automatically stops running the shell and reboots after 72 hours of 
continuous use. This time period is not configurable. 

 

5.1.1 Boot from Bootable Rescue Disk 

1.  Insert the Bootable Rescue Disk and restart your computer, and then enter the 

BIOS to set the CD/DVD ROM as the first boot device. 

2.  After entering the Total Recovery Pro 7 Pre-OS main console, you can then 

backup and restore your computer, clone a hard disk and many other useful 

functions.  

5.1.2 Boot into Windows via a USB Drive or USB Key                                             

 

With the USB Hot Drive, you can restore the entire system from a Windows 

environment. 

Follow the steps below to use the USB Hot Drive: 

1. Connect the USB device, start your computer, enter the BIOS to set the USB 

device as the first bootable option, and save your settings.  

2. Restart the system and boot from the USB device. 



3. After entering Windows, use Total Recovery Pro 7 to restore the system. All of 

Total Recovery Pro 7’s other features will also be available to you. 

5.2 Total Recovery Pro 7 Pre-OS Main Console 

After you enter the Total Recovery Pro 7 Pre-OS, you will see the following window.  

 

 

5.2.1 Quick Start 

Back Up Computer(s) – Click here to back up partition(s) or the entire hard 

drive for your system. 

Restore Your Computer – Click here to restore from a complete backup point. 

5.2.2 Backup (Computers) 

 

5.2.2.1 Back up Your Computer in PE Manager 

 

1. Click Back Up Computer(s). 

2. Enter a name for your new Complete Backup, and click Next. 



3. Select the partition(s) or the entire hard disk to back up, and click Next. 

 

 

Tip 
This backup performed in PE is not supported by Universal Restore.  

4．Enter the storage path and click Go to, or select a destination location on a 

hard drive, USB storage medium, or a network location to store the image file. 

Some optional settings will be displayed if you click Advanced; these include: 

compression mode, password protection, image split, backup priority, and network 

connection speed. 

5. Click Next. 

6. Review the information and settings that have been specified. Click Next to 

launch the backup process, or click Previous to modify setting(s). 

7. Click Finish to return to main console. 

 

 

5.2.3 Restore Your Computer  

 

5.2.3.1 Restore Your Computer in Pre-OS Manager 

To restore a partition or the entire hard drive, please do the following: 

1. Enter into Total Recovery Pro 7 Pre-OS manager. 

2. Click Restore Your Computer. 

3. Select a backup image from the list, or click here to select an image file stored 

on a network share. Click Next to continue. 

4. Select a Complete Backup point or any Incremental Backup point to restore 

from, and click Next. 

5. Select to restore a single partition or the entire hard drive, and click Next.  



6. Select a destination partition or a destination hard drive to be restored from the 

image file, and click Next. If you choose to restore a single partition, click Yes 

to launch the restoration process. 

7. To restore the entire hard disk, select a restore option.  

a. Select the checkbox to modify the destination partition size. 

b. Do not select if you fear information loss on multiple systems or 
hidden partition. 

If you selected option a, double click the partition Capacity to be resized from 
the list. If you selected option b, skip to step 9. 

8. When it shows the structure of the destination partition, double click the 
highlighted partition and modify its size, and click Next to continue. 

9. Click OK to begin the restoration process.  

After the restoration process is complete, Windows will automatically reboot.  

5.2.3.2 Perform Universal Restore 

You can restore the system partition or the entire hard drive of the selected client 

to a dissimilar hardware. 

1. Launch Total Recovery Pro 7 Pre-OS manager.  

2. Click Restore Your Computer.  

3. Select a backup image from the list, or click here to select an image file 

supported by Universal Restore. Click Next to continue. 

 

Note 
The image you selected needs to be supported by Universal Restore. 
More information about Universal Restore, please refer to section 
4.1.3.  

4. Select a Complete Backup point or any Incremental Backup point to restore 

from, and click Next. 

5. Select to restore with Universal Restore, and click Next.  



 
Tip 
If you select the utility, you can get accurate restored data in the 
process of Universal Restore.  

 

6. Select to restore a single partition or the entire hard drive, and click Next. 

7. Select a destination partition or a destination hard drive to be restored from 

the image file, and click Next. If you choose to restore a single partition, click 

Yes to launch the restoration process. 

8. To restore the entire hard disk, select a restore option.  

a. Select the checkbox to modify the destination partition size. 

b. Do not select if you fear information loss on multiple systems. 

If you selected option a, double click the partition Capacity to be resized from 
the list. If you selected option b, skip to step 10. 

9. When it shows the structure of the destination partition, double click the 
highlighted partition and modify its size, and click Next to continue. 

10. Click Next to begin the restoration process.  

11. Click Finish to complete the process. 

 

5.2.4 Clone Tab 

5.2.4.1 Clone Drive 

Clone Drive duplicates one hard drive to another. It eliminates the need to re-

install the operating system, drivers and applications, and enables you to upgrade 

a new hard drive with only a few clicks. 

 

 

Tip 
To use this function, you will need to have at least two hard drives on 
your computer. 

The target hard drive should have enough space to store the data of the 



source hard drive. 

1.  Select Clone and then click Clone Drive. 

2.  Select the Source Disk (top pane) and then the Destination Disk (bottom pane). 

You can choose to modify the Destination Partition Size manually by selecting 

Modify the destination partition size. You can also choose not to modify 

the Destination Partition Size by selecting Keep the partition size of the 

destination drive the same as the source drive. Click Next to continue. 

 

Tip 
If you select Keep the partition size of Destination Hard Drive the 
same as the Source Hard Drive, please skip to step 4. 

If the Hard Drive you want to clone is going to boot your system, select 
Keep the partition size of Destination Hard Drive the same as the 
Source Hard Drive. 

3.  You can alter the Destination Partition size by double-clicking the specified size 

of the Destination Partition and change the size in a popup dialog box. Click 

Next to continue. 

4.  After confirming your selections, click Clone Now to proceed or you can click 

Previous to change your selection. If the system is busy, Total Recovery Pro 7 

will try to automatically clone again. 

 

Note 
The cloning process will overwrite all data on the destination disk. Click 
Continue to begin the cloning process. You can also click Cancel to exit. 

5.  Click Shutdown to complete the cloning process. 

 



5.2.4.2 Clone Partition 

With Total Recovery Pro 7, you can copy data from the source partition into the 

destination partition. 

1.  Select Clone and then click Clone Partition. 

2.  Select a Source Partition in the Hard Drive (top pane). 

 

Note 
You can only choose one partition at a time. 
The Source Partition and the Destination Partition cannot be chosen at the 
same. 

 

3.  Select a Destination Partition in the original Hard Drive or another Hard Drive 

(bottom pane), then click Next to continue. 

 

 

Tip 
The selected destination partition must have enough space to hold the 
data of the source partition. 

 

4.  After confirming your selections, click Clone Now to start the duplicating 

process or you can click Previous to change your selections. You can start the 

cloning process by clicking Start Clone. If the system is busy, Total Recovery 

Pro 7 will automatically try to clone again.  

 

 

Tip 
The cloning process will overwrite all data on the destination disk. Click 
Continue to begin the cloning process, or click Cancel to exit. 

 

5.  Click Return to Main Console to complete the process. 



 

5.2.5Analyze Tab 

5.2.5.1 Check Backup Image  

Use this function to check if a complete backup image file is valid and can be used 

for restoration. 

1. Select the Analyze tab in the left pane, and then select Check Backup 

Image.  

2. Enter the storage path of the image you want to check, and click Go to to 

select the image. You can also select the storage path of the image you want 

to check and click Next. 

3. Select to check either the Complete or Incremental Backup point, and click 

Next to   continue. 

4.  After checking the backup image, click Finish to complete the Image Backup 

Check. 

5.2.5.2 Check Hard Disk Errors 

In this section, you can check if the backup data in your complete backup image 

file is valid. 

1. Select Analyze tab and click on Check Hard Disk for Errors icon. 

2. Select the disk to be checked.  

3. Do one of the following to launch checking process. 

a. To check for errors without repairing them, click Check Now without 

selecting either of the check boxes above. 

b. To check and correct system errors, make the appropriate selections in the 

check boxes, then click Check Now. 

4. Click OK to complete the process. 

5. Click Finish to return to the main console. 



 

5.2.5.3 Run Command Shell 

The command shell executes programs and displays their output on the screen by 

using individual characters similar to the MS-DOS command interpreter 

Command.com. You can use the command shell to create and edit batch files (also 

called scripts) and to automate routine tasks. You can perform operations more 

efficiently by using batch files than you can by using the user interface. 

1. Select Analyze tab and click on Open Command Shell Window icon. 

2. Enter the command in the pop-up window and press Enter key. 

3. Type exit and press Enter key to return to main console. 

 

5.2.6 Network Tab 

5.2.6.1 Network Adapter Configuration 

Total Recovery Pro 7 can back up to, or restore from a network location. To use 

this feature, you should first configure your network settings. From here, you can 

configure the IP Address Settings and DNS Server Settings. 

Click the Network tab and then select Network Adapter Configuration. You 

will see the following screen: 



 

 

From here, you can setup your network adapter, IP address, Subnet mask 

and Default gateway. 

If you have more than one network adapter on your system, select the 

adapter to be used from the dropdown menu. 

IP Address Settings: 

 Obtain an IP address automatically: If your network supports DHCP 

(Dynamic  Host Configuration Protocol), this option will automatically 

obtain an IP address from a DHCP server or a Point-to-Point Protocol 

(PPP) dial-up network access server.  Total Recovery Pro 7 Client sets 

DHCP as the default option. 

 IP address: Choose this option to manually specify an IP address for 

your network. This option can be used when automatically obtaining 

an IP address fails or when there is an IP address conflict. 



If your computer is on a Local Area Network (LAN), you can configure the 

LAN settings to back up images to or restore from a network location. 

DNS Server Settings: 

 Obtaining a DNS server address automatically: DNS (Domain Name 

System) is an internet service that translates domain names into IP 

addresses. It is a system for name resolution, suitable for network 

computers with fixed IP addresses. Total Recovery Pro 7 sets DHCP as 

the default option. 

 Use the following DNS server address: Manually specify the DNS 

server address if needed. You can enter a preferred one and an 

alternative one (if the former one is unavailable). 

 

5.2.6.2 Map Network Drive 

In this section, you can use the network folder as the local one, and assign a drive 

letter for it. Doing so allows you to access the image files in that folder more 

conveniently. 

After the network resource is successfully connected, you can access all of its data 

just like on your local computer.  

1. Select Network tab and click on Map Network Drive icon. 

2. Select a drive letter from the drop-down list to map the shared resource 

3. Enter the computer share name of the resource in this format: \\Server 

name\share name. Or click Browse to locate the resource.  

4. Click Save. 

5. In the User name and password dialogue box, type your user name in this 

format: domain name\username. Enter password if prompted.  

 

Note 
All mapped drive(s) will be removed if you reboot or shut down this 
computer.  

 



5.2.6.3 iSCSI Initiator 

 First, ensure that the ISCSI initiator is installed on the machine. On Windows 

Vista, it is installed by default; other Windows systems require a download and 

manual installation. With this feature, users may connect to the iSCSI device and 

access a great deal of information and configuration options. For more details 

regarding the configuration of iSCSI initiator, please refer to 4.5.5.  

 

5.2.6.4 Launch Web Brower 

  Click the button, users will go through the website in PE. 

 

5.2.7 Utilities 

5.2.7.1 Preview Backup Image 

Preview the content of the specified partition of a complete backup image to make 

sure you can only restore the needed partition(s).  

1. Click on the Tools tab, and then select Preview Backup Image. 

 

Note 
If you have mounted an image before, you will be prompted to dismount 
the previous image. Click Continue to dismount the previous image, or 
Cancel to exit this process. 

2. Enter the storage path of the image you want to preview and click Go to to 

select the image, or select the storage path of the image you want to preview and 

click Next. 

3. Select a complete backup point or an incremental backup point, and click Next. 

4. Select the partition you want to preview, and click Mount to load the image into 

the system. 

5. You can now browse and copy data on the preview drive in Windows® Explorer.   

6. You can click Yes to mount another image, or No to return to the main console. 



If you would no longer like to preview the image, select Unmount Preview Drive 

on the Tools tab to close the previewed partition.  

 

5.2.7.2 Add Driver 

If Total Recovery Pro 7 cannot detect the compatible and available driver for the 

application you need, you can manually install a third party driver.  

5. Select the Tools tab and click on the Add Driver icon. 

6. Select the driver file on the local computer or on the network.  

 

*Select a driver file on your local computer or shared network. 

3. Click OK.  

 

Note 
All mapped drive(s) will be removed if you reboot or shut down the 
computer. 



 

The added driver(s) can now work with the matched applications.  

 

5.2.7.3 Open Explorer Window 

Select Tools tab, then click Open Explorer Window, files and folders on your 

computer will be displayed. 

5.2.7.4 Unmount Preview Drive  

The utility can remove the preview backup image 
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• Total Recovery Pro 7 Image 

A Total Recovery Pro 7 image is a file containing a complete copy of a 

computer’s hard drive or partitions on that hard drive. With this image, you 

can transfer the contents of a hard drive to a portable medium such as a 

recordable CD/DVD, USB drive, or to another hard drive, for later restoration 

when needed.  

• Recovery CD/DVD 

The Recovery CD/DVD allows users to restore their system by inserting this 

disc into their CD/DVD-ROM drive. Once the system is booted up, the 

Recovery CD/DVD will restore the system automatically based on the content 

contained on the Recovery CD/DVD.  

• Clone (Copy) Partition/Drive 

The term "cloning" refers to the physical reading of all sectors of a source 

partition / disk and the subsequent writing of this raw sector information to 

the corresponding sectors of a destination partition or disk. The size, file 

system formats, brand of the source partition/disk and target partition/disk 

can be different. 

• System Partition 

The system partition refers to the disk volume that contains the hardware-

specific files that are needed to launch Windows (for example: Ntldr, Boot.ini, 

and Ntdetect.com). On dynamic disks, this is known as the system volume. 

• Boot Partition 

The boot partition refers to the disk volume that contains the Windows 

operating system files (by default, in the WINDOWS folder) and its support 

files (by default in the WINDOWS\System32 folder). The boot partition can, 

but is not required, to be the same partition as the system partition. There will 

be one (and only one) system partition, but there will be one boot partition for 

each operating system in a multi-boot system. On dynamic disks, this is 

known as the boot volume. 

• Universal Restore 

Universal Restore allows you to restore your system partition and active 



partitions to different hardware configurations or virtual machines, such as a 

replaced motherboard or hard drive controller. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 7: Appendix 

7.1 Frequently Asked Questions 

Q. How long does it take Total Recovery Pro 7 to back up or restore a 

system? 

A: This depends on the amount of data on your system. However, Total Recovery 

Pro 7’s technology minimizes the time it takes to perform a backup. 

Q. I started Total Recovery Pro 7 in Windows immediately after the 

installation was completed, but a message says that I have to restart 

my computer in order to run it. Why? 

A: You have to restart your computer after installing Total Recovery Pro 7 in order 

for all configuration changes to take effect. 

Q. When I restored a partition from an image file, Total Recovery Pro 7 

prompted me that “There is not enough space on the Destination 

Partition”. But I’m sure the free space on the Destination Partition is 

larger than the used space in the Source Partition. Why am I getting 

this prompt? 

A: If data at the end of the source partition cannot be moved, Total Recovery Pro 

7 will prompt you with this notice.  

Q.  I created an image for Drive C: on two CD-R discs. Why can’t the disc 

be mounted as a temporary partition? 

A:  Mounting a partition requires all the backup data of the drive. If you use one of 

two discs, it cannot provide the complete information. To solve this problem, 

copy the image files from the two discs to the hard drive and then mount it as 

a temporary partition. This problem cannot be overcome by using multiple 

CD/DVD drives. 

Q.  While creating a Recovery CD/DVD, an error message appears.  



A:  This error may occur if the quality of the recordable CD/DVD media is not good, 

or the disc is incompatible with the recorder. To solve this problem, please try 

a different brand of CD/DVD media or upgrade your CD/DVD recorder.  

Q.  Do I need to do anything before installing Total Recovery Pro 7? 

 A: We recommend running Windows CheckDisk to scan for hard drive errors.  

Q. Bad Sectors have already been detected on a hard drive. How does 

this affect my backup and restore options? 

A:  Total Recovery Pro 7 will try to copy all used sectors when performing a 

Complete or Incremental backup. You may be prompted to skip a bad sector 

or a job could fail due to bad sectors. Therefore, it’s recommended to run 

Windows Check Disk command to detect and repair hard drive errors, or use 

utilities provided by your hard drive manufacturer, when attempting to resolve 

this type of problem.   

Q. Can Total Recovery Pro 7 fix my system after my hard drive has been 

accidentally formatted or repartitioned? 

A: Yes — if Total Recovery Pro 7 was installed prior to the incident. 

Q. Can I use disk tools such as Fdisk, PartitionMagic and Norton Speed 

Disk after installing Total Recovery Pro 7 on my computer? 

A: There is no known resource conflicting with those utilities. 

Q. I’ve installed three operating systems on my computer, including Linux. 

Can Total Recovery Pro 7 protect all three systems? 

A: Total Recovery Pro 7 protects multiple Windows operating systems completely, 

and we recommend using Back Up Computers to protect the non-windows 

systems.  

Q. Does Total Recovery Pro 7 work in Windows Safe Mode? 

A: Total Recovery Pro 7 does not work in Windows Safe Mode. 

Q. Can Total Recovery Pro 7 protect my PC from a destructive virus? 



A: While Total Recovery Pro 7 cannot prevent the actual virus attack, it can 

restore your computer to a point before the attack occurred, recovering your 

files and effectively removing the virus.  

Q.  Does Total Recovery Pro 7 Provide support for Windows® advanced 

power management? 

 A:  Total Recovery Pro 7 supports all Windows® advanced power management 

features (Standby, Sleep, Hibernate). 

Q.  How can I restore without having a DHCP Server on the network? 

A: If the DHCP service is not running on your network, you’ll have to manually 

enter a static IP address to access the network through Network Adapter 

Configuration in Pre-OS. 

Q. What happens if my PC misses a scheduled backup? 

A: Total Recovery Pro 7 will start the missed backup automatically at next boot 

up if you select the checkbox in the setting interface saying If the computer 

shuts down, run the missed tasks when it boots next time. If you don’t 

select that checkbox, Total Recovery Pro 7 will start the next scheduled 

backup at next boot up. 

Q.  Does the Total Recovery Pro 7 conflict with any other applications? 

A: Please close the following applications when launching Total Recovery Pro 7: 

Utimaco and SafeGuard. 

Q. Which partition types does Total Recovery Pro 7 recognize? 

A: NTFS, FAT, FAT32, Linux Ext2 and Ext3. 

 

Q.  Why is my backup image larger than the source partition or hard disk?  

A.  The source partition or hard disk may have too much of fragmentation. 

Defragment it and then run the backup again. 

 

Q.  How can I access the computer outside the Workgroup through the 

network under the Pre-OS? 



A.  Click on the Tools tab and select Map Network Drive. And then map the 

directory on the remote computer as you wish. 

Q.  How can I get SDK download location correctly before I use the 

Convert Backup to Virtual Disk feature? 

A.  VMware Home Page (www.vmware.com) ->Download ->VMware SDK&APIs -

>Virtual Disk ->VMware Virtual Disk Development Kit 
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